
Uestion 1:

 
There is a better method to enable or disable services on your computer than using msconfig and 

hardware profiles. When using msconfig, you might disable some services that are necessary to 

boot the system. Which of the following should be used to enable or disable services. 

a. Device Manager 

b. Event Viewer 

c. Microsoft Management Console 

d. Local Security Policy 

Answer is: Microsoft Management Console 

Question 2: 

What is the key combination to Quit a program through Task Manager that is not responding? 

a. Alt + Del 

b. Ctrl + Alt + Del 

c. Ctrl + Del 

d. Shift + Alt + Del 

Answer is: Shift + Alt + Del 

Question 3: 

Windows XP tracks whatever files that load during every boot and application launches, and the 

operating system uses that information to prefetch files into RAM. These prefetch data are 

parsed into a file named __________ located in the Windows\Prefetch folder on the boot drive. 

Every three days, a limited defragmentation operation automatically occurs in the background 

during idle for only those files in that file to further speed up the computer’s file access. 

a. Defrag.Sys 

b. Prefetch.Sys 

c. Defrag.ini 

d. Loyout.ini 

Answer is: Defrag.ini 

Question 4: 

Accelerator (hot) keys: Several menu commands, such as File, Edit, Table, or Tools, have one 



underlined letter as shown. The command associated with the underlined character can be 

quickly executed if that character is entered on the keyboard immediately after the _____ key is 

pressed. 

a. Shift 

b. Alt 

c. Ctrl 

d. Windows 

Answer is: Alt  

Question 5: 

An icon with an arrow in its lower-left corner, which can be clicked for quick access to the 

object it represents, is a(n): 

a. Application icon 

b. Folder (Directory) icon 

c. Document icon 

d. Shortcut icon 

Answer is: Folder (directory) icon  

Question 6: 

A common name given to the bitmapped desktop image (usually a picture) that serves as a 

background for the entire desktop is: 

a. Wallpaper 

b. Theme 

c. Texture 

d. Mosaic 

Answer is: Wallpaper  

Question 7: 

Which of the following statements about Windows XP features is/are correct? 

a. Windows XP can automatically download updates. 

b. Windows XP offine files allows you to synchronize your files with your file server. 

c. If Fast User Switching is enabled, you cannot use offline files. 

d. There is a “System Restore” functionality within Windows XP. 

Answer is: Windows XP offline files allows you to synchronize your files with your file server.  

Question 8: 

Which of the following is/are valid Window’s file names? 

a. Expert-Rating 

b. Expert Rating 

c. Expert*Rating 

d. 643764736 

e. expert rating certifications! 

Answer is: expert-rating  



Question 9: 

Which statement(s) about the Recycle Bin is/are correct? 

a. All deleted files except media files are sent to the Recycle Bin. 

b. You can restore any selected files from the Recycle Bin folder by right clicking and then 

selecting Restore. 

c. The Recycle Bin stores files for one month before permanently deleting them. 

d. More than one file at a time cannot be restored from the Recycle Bin. Odesk test 
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Answer is: The Recycle Bin stores files for one month before permanently deleting them.  

Question 10: 

Which of the following statements about the file security levels while browsing is/are correct? 

a. Low is designed with the minimum safeguards. 

b. Under Low security, active content such as scripting, runs without prompting. 

c. Medium-low is the same as Medium but with less frequent prompts. 

d. Medium is the default security level for the Internet. 

e. All of the above 

Answer is: All of the above 

Question 11: 

Which of the following would be a System Restore feature in Windows XP? 

a. It allows you to take a quick backup of your important data. 

b. It helps you recover data that has been lost due to a hard disk crash. 

c. It allows you to quickly clean up unwanted files, folders, and desktop icons. 

d. It allows you to restore your computer to a previous state in case of a system problem. 

e. It allows you to quickly reinstall Windows XP in case of need. 

Answer is: It allows you to restore your computer to a previous state in case of a system 

problem.  

Question 12: 

How can you customize Advanced Start menu options in windows XP operating system. 

a. Right click on the Taskbar and click the Customize button. 

b. Right click on the Taskbar, choose Properties, click on Start Menu, and click the Customize 

button. 

c. Right click on the Taskbar and choose open all users. 

d. Left click on the Taskbar; choose Properties. 

Answer is: Right click on the Taskbar, choose Properties, click on Start Menu, and click the 

Customize button.  

Question 13: 

You can create and edit files using the Windows Notepad. What are the extensions of a file that 

has been created using Notepad? 

a. Doc 

b. Text 

c. Txt 



d. Html 

Answer is: Text  

Question 14: 

What happens when you hold down the Windows button key and press the E key? 

a. It opens the Windows Explorer. 

b. It opens the Internet Explorer. 

c. It opens the default search engine. 

d. It opens the color settings. 

Answer is: It opens the Windows Explorer. 

Question 15: 

You are logged in as an administrator to the computers on your small local network and you 

want to change the names of those computers and the workgroup so that their names are more 

informative. One way to change the names would be to: 

a. Open the System control panel. Select the System tab and then click Change. Enter the desired 

name for the computer and click OK. 

b. Open the System control panel. Select Change Name from the Edit menu and then click 

Change Name. Enter the desired name for the computer and click OK. 

c. Right click the Desktop and select Personalize. Select the Computer Name tab and then click 

Change. Enter the desired name for the computer and click OK 

d. Open the Performance and Maintenance control panel. Select the Computer Name tab and 

then click Change. Enter the desired name for the computer and click OK. 

e. Right Click on My Computer icon, choose properties and select tab ‘Computer Name’ or (use 

run command and put sysdm.cpl) and click on the Change button. Enter the desired name for 

computer and click OK. 

Answer is: Open the Performance and Maintenance control panel. Select the Computer Name tab 

and then click Change. Enter the desired name for the computer and click OK.  

Question 16: 

The _____________ is a large hidden file where Windows XP finds information about all of the 

hardware, software, and various settings and user options. 

a. Windows Registry 

b. Finder 

c. Preferences 

d. Windows SysOps 

Answer is: Preferences  

Question 17: 

Which of the following activities can you accomplish with the Remote Desktop feature in 

Windows XP? 

a. You can get a miniature view of your desktop by clicking on the Desktop icon. 

b. You can automatically clear up unwanted Desktop icons. 

c. You can view files and documents on your computer’s desktop from a coworker’s computer. 

d. You can view files and documents on any computer’s desktop from your computer. 



Answer is: You can view files and documents on your computer’s desktop from a coworker’s 

computer.  

Question 18: 

The hard-drive utility tool in Windows XP for automatically fixing file system errors or for 

searching for and attempted recovery of bad sectors is: 

a. CheckDisk (CHKDSK) 

b. SystemCheck (SYSCHK) 

c. DiskFix (DSKFX) 

d. DiskScan (DSKSCN) 

Answer is: CheckDisk (CHKDSK) 

Question 19: 

By hovering the mouse pointer over the clock, what happens? 

a. It displays the time in a bigger font. 

b. It will speak out the time through the speaker connected to the computer. 

c. It will show the time in analog format. 

d. It will display the current day of the week and the date. 

Answer is: It will speak out the time through the speaker connected to the computer. 

Question 20: 

The left side of the Start menu contains two parts, separated by a thin horizontal line. The 

Windows XP term for manually inserting a shortcut to one of your chosen applications into the 

top part of the left side (by using the right-context menu of the application in Windows Explorer) 

is called: 

a. Attaching an application to the Start menu. 

b. Pinning an application to the Start menu. 

c. Placing an application into the Start menu. 

d. Porting an application to the Start menu. 

Answer is: Porting an application to the Start menu. 

Question 21: 

Which of the following statements about Windows XP Internet Connection Sharing (ICS) is/are 

true? 

a. Using ICS, you can connect different computers to the Internet using just one dial-up 

connection, however you require at least two modems. 

b. You require a router for using ICS. 

c. Using ICS, a single computer can connect to more than one dial-up connection. 

d. Using ICS, a single computer can connect to a dial-up and DSL connection simultaneously. 

e. Using ICS, multiple computers can connect to the Internet through only one dial-up 

connection. 

Answer is: Using ICS, a single computer can connect to more than one dial-up connection.  

Question 22: 

The older version of the Windows XP Desktop is called the “Windows Classic” look. One way 

to get the Windows Classic Desktop from the new default Windows XP Desktop is to: 



a. In the System control panel, select Properties from the View menu. Select the Desktop tab and 

click on the Desktop pull-down list and select Windows Classic. Click OK. 

b. Right-click on the desktop and choose Properties. Select the Themes tab and click on the 

Theme pull-down list and select Windows Classic. Click OK. 

c. In the Display control panel, select Properties. Select the Desktop tab and click on the Theme 

pull-down list and select Windows Classic. Click OK. 

d. Right-click on the desktop and choose Themes. Select the Desktops tab and click on the 

Desktop pull-down list and select Windows Classic. Click OK. 

Answer is: In the System control panel, select Properties from the View menu. Select the 

Desktop tab and click on the Desktop pull-down list and select Windows Classic. Click OK.  

Question 23: 

Starting with Windows 95, the File Manager tool for organizing and controlling the files and 

folders of the computer’s storage systems, such as the hard drive(s) and disk drive(s) has been 

called: 

a. Windows Manager 

b. Internet Explorer 

c. Windows Explorer 

d. Windows Task Manager 

Answer is: Windows Explorer 

Question 24: 

Windows XP includes a new type of view for folders that contain graphics files. This folder view 

is called _________ and displays small images of all the graphics in the folder in the bottom 

right-hand pane of Windows Explorer and a large image of a selected picture in the top right-

hand pane. 

a. Gallery 

b. Images 

c. Pictures 

d. Filmstrip 

Answer is: Filmstrip 

Question 25: 

Which of the following statements regarding Windows XP user access is/are correct? 

a. Multiple users cannot switch between accounts without restarting the computer. 

b. Multiple users can switch between accounts without restarting the computer. 

c. Windows XP does not support multiple user access. 

d. None of the above 

Answer is: None of the above  

Question 26: 

With Windows XP, the default display resolution is 800×600 in 32-bit true color. With some 

computers 32-bit video tends to slow down screen redraws. How could you drop the screen depth 

to 16 bits instead of 32 bits in order to speed up the display in older PCs, especially laptops? 

a. In the Colors control panel, set the Colors option to Medium (16 bits). 

b. In the Color Management control panel, set the Color depth to Medium (16 bits). 



c. In the System control panel, set the Monitor depth to 16 bits. 

d. In the Display Properties dialog box, on the Settings page, set the Color quality option to 

Medium (16 bits). 

Answer is: In the Display Properties dialog box, on the Settings page, set the Color quality 

option to Medium (16 bits).  

Question 27: 

A new function of Windows XP that allows two or more users in a local network to use only one 

Internet connection by routing all the Internet traffic through one computer is called 

__________. 

a. Internet Routing 

b. Windows Internet Sharing (WIS) 

c. Internet Connection Sharing (ICS) 

d. Windows Connection Sharing (WCS) 

Answer is: Windows Internet Sharing (WIS)  

Question 28: 

Which of the following statements is/are correct regarding the grouping of Windows tabs? 

a. Only Windows of the same program can be grouped into one tab. 

b. You can group windows of all open programs into one tab. 

c. You can group windows of only two programs at a time. 

d. There is no option to group tabs in Windows XP. 

Answer is: There is no option to group tabs in Windows XP. 

Question 29: 

Microsoft makes available a tool called the _____________________ for checking computers 

with a Windows operating system. This tool helps remove infections left by third-party software 

installed on the computer and displays a report describing the outcome in a log file named 

mrt.log in the %WINDIR%\debug folder. 

a. Microsoft Reliability Tool 

b. Microsoft Windows Malicious Software Removal Tool 

c. Microsoft Windows Antivirus Tool 

d. Microsoft Recovery Tool 

Answer is: Microsoft Windows Malicious Software Removal Tool 

Question 30: 

Windows XP usually retains copies of old drivers when newer versions of them are installed or 

upated. If the new drivers have problems, the user can return to the previous version. Does this 

new Windows XP feature work with printer drivers? 

a. Yes 

b. No 

Answer is: Yes  

Question 31: 

Windows XP has a new user system. Its new user system: 

a. Was inherited from Windows 98. 



b. Was inherited from Windows 3.x. 

c. Was inherited from Windows NT/2000. 

d. Was not inherited from any prior Windows O/S. 

Answer is: a, b, c 

Question 32: 

A new feature introduced in Windows XP that allows another user to log in and use the system 

without having to log out the previous user and Quit any running applications is known in 

Windows XP as: 

a. Multiple user Login 

b. Simulcasting 

c. Fast user switching 

d. Multiprocessing 

Answer is: Fast user switching 

Question 33: 

The Windows XP installs its search function that, by default, has an animated dog character, 

Rover. Which of the following is/are true? 

a. Rover could be replaced with another animated character or with no character at all. 

b. Rover cannot be replaced by another character. It is a permanent feature. 

c. Rover could be replaced by another character, but another animated character must be used 

(instead of having no character at all). 

Answer is: Rover could be replaced by another character, but another animated character must be 

used (instead of having no character at all).  

Question 34: 

What does the Desktop Cleanup Wizard do? 

a. It removes suspected virus shortcuts from the desktop. 

b. It removes the desktop wallpaper. 

c. It removes the desktop shortcuts that have never been used. 

d. It sends all the desktop icons to the Recycle Bin. 

Answer is: It removes the desktop wallpaper. 

Question 35: 

Windows XP has several command-line utility tools for troubleshooting the computer. Suppose 

that your computer seems to have a problem with connecting to the Internet. Before reporting 

your connectivity problems to your ISP, which tool could you use to display the current TCP/IP 

network configuration values and to refresh the Dynamic Host Configuration Protocol (DHCP) 

and Domain Name System (DNS) settings? 

a. Ping 

b. Ipconfig 

c. Tracert 

d. Msconfig 

Answer is: Ipconfig 



Question 36: 

Which key combination would you use to flip between open windows? 

a. Alt + Shift 

b. Alt + Tab 

c. Ctrl + Tab 

d. Ctrl + Alt 

Answer is: Alt + Shift 

Question 37: 

What type of icons are displayed in the system tray? 

a. Icons of media-related programs. 

b. Icons of programs developed by Microsoft. 

c. Icons of programs that are loaded into memory. 

d. All of the above 

Answer is: Icons of programs developed by Microsoft. 

Question 38: 

Which of the following statements about icons on the desktop is correct? 

a. You can rename an icon by left-clicking the mouse button and selecting Rename. 

b. You can rename an icon by right-clicking the mouse button and selecting Rename. 

c. You can delete an icon by left-clicking and selecting Delete. 

d. You cannot rename an icon. 

Answer is: You can rename an icon by right-clicking the mouse button and selecting Rename.  

Question 39: 

State whether the following statement is true or false. 

With Windows XP, you cannot specify that files with certain file name extensions should always 

open in the same program. 

a. True 

b. False 

Answer is: True 

Question 40: 

Which of the following statements is true if you open an existing file, make changes to it, and 

save it with a new name? 

a. The original file will be deleted. 

b. The original file remains unchanged. 

c. The changes will be saved in the original file 

d. The original file is sent to the recycle bin 

Answer is: The original file remains unchanged. 

Question 41: 

Which of the following features is/are available in windows xp? 

a. A built-in cd burner 

b. Windows media player 

c. Windows antivirus 



d. Internet connection firewall 

e. Microsoft excel 

Answer is: a,b,d 

Question 42: 

The Microsoft file format that contains the bitmapped graphics and metadata for the skins used 

in the three preinstalled windows xp visual themes is: 

a. Msthemes 

b. Msstyles 

c. Msskins 

d. Msluna 

Answer is: Msthemes 

Question 43: 

Which of the following statements about the stand by option while shutting down your computer 

is/are correct? 

a. It waits for 5 minutes before shutting down the computer. 

b. It helps to conserve power by shutting off some hardware, like the hard disk. 

c. It shuts down the computer for a specific time and then restarts it. 

d. Stand by will save your desktop and all open files to a special windows file called hiberfil.sys. 

This file usually resides in the computer’s root folder (c:\hiberfil.sys). 

Answer is: It helps to conserve power by shutting off some hardware, like the hard disk. 

Question 44: 

While viewing file names through the windows explorer, what happens if you drag and drop a 

file named letter1.txt on top of another file named letter2.txt lying in the same folder? 

a. The contents of letter2.txt will be replaced by the contents of letter1.txt. 

b. The contents of letter1.txt will be replaced by the contents of letter2.txt. 

c. The contents of letter1.txt will be appended to the contents of letter2.txt. 

d. The contents of letter2.txt will be appended to the contents of letter1.txt. 

e. Nothing will Happen. 

Answer is: Nothing will happen. 

Question 45: 

Which of the following type of objects can you search on your computer and on the network, 

using windows xp search companion? 

a. People in your contact list 

b. Pictures 

c. Documents 

d. Windows help 

e. All of the above 

Answer is: All of the above 

Question 46: 

You can create and edit files using the windows notepad. What is the extension of a file that has 

been created using notepad? 



a. Doc 

b. Text 

c. Txt 

d. Html 

Answer is: Txt 

Question 47: 

You have created a directory called test that includes the files test1.txt, test2.txt, test3.txt, 

test4.txt, test5.txt, and test6.txt. How can you select test2.txt, text3.txt, and test6.txt from the list 

of files visible in the windows explorer? 

a. Press ctrl and click on the three required files, one by one. 

b. Press shift and click on the three required files, one by one. 

c. Press alt and click on the three required files, one by one. 

d. Right-click each file name, one by one, and choose the cut option. 

Answer is: Press ctrl and click on the three required files, one by one. 

Question 48:

 
What should you type on the command prompt to return back to windows? 

a. Quit 

b. Return 

c. Leave 

d. Exit 

Answer is: Exit 

Question 49: 

What happens when you choose ClearType for your screen fonts in Windows XP? 

a. Only the black and white text will be visible. 

b. Only the text in primary colors will be visible. 

c. The font resolution is improved. 

d. The font size will automatically adjust to the screen area of the monitor. 

Answer is: Only the text in primary colors will be visible.  
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